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Abstract:- Rapid civilization leads to construction of thousands of buildings in urban areas. Now days, multi-storied R.C. framed 

structures are common in urban regions in the cities like Hyderabad, Bangalore, New Delhi, Chennai, Maharashtra, Pune etc. Due to 

thickly populated urban regions the buildings are extending vertically or going high or becoming more slender. Decades are evident 

that traffic volume in urban regions is high when compared to semi urban or rural regions. Therefore, the parking of vehicles is 

significant issue in urban regions leading to consider the parking storey in a building itself. Hence, parking is unavoidable in multi-

storey buildings in urban regions in turn leading to create vertically irregular building. To study the effect of vertically irregularity in 

buildings created due to parking or by some other instance. 4 mathematical Models of R.C. framed structures are created in ETAB 

2016 version. From literature it can be observed that buildings which are having floating columns are more sustainable due to 

earthquake loading as compared to conventional R.C framed structure and unable to transfer the inertia forces safely to the ground. 

To study the effect of earthquake on this kind of buildings, Equivalent linear static analysis has been considered. The parameters like 

fundamental natural time period, fundamental mode shapes with modal mass participation factor, storey displacements, storey drifts, 

and base shear have been studied in detail 

 

PROJECT TITLE:   

Computer Aided Design, Analyze and Drafting Of Multi Storey R.C.C Structure Using ETABS  

 

PROJECT DESCRIPTION: 

AIM: 

“Analysis & design of multistoried commercial building” 

Analysis is done by using ETABS software for analysis of beams & columns 

DESIGN: 

Designing of the structure is done with the help of limit state method by using ETABS software. Design consist of the design of 

slab, beams, columns and staircase. 

STATEMENT OF PROJECT 

SALIENT FEATURES: 

1) Utility of building                 :   Commercial building 

2) No. of storey      :   G+4 

3) No. of staircases                 :   4      

GEOMETRIC DETAILS: 

1) Length of building                  :  20.42m 

2) Width                                         :  16.21m         

3) Height of building    :  18.6m 

No of storey                         :   4 

Floor to floor height              :    3 

No. of lift                               :    2 

                        Type of walls                           :   Red Brick wall     

          Thickness of outer walls               :   230 mm (9”) 

          Thickness of inner walls              :   115 mm (4”) 

          Foundation                                    :   By isolated R.C.C footing                                                                       

       

 MATERIALS: 

        Concrete grade                                :  M 20   

        All steel grades                                :  Fe 500  

       Bearing capacity of soil                    :  400 KN/m²     
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 CHAPTER -1 

INTRODUCTION 

It cannot be over emphasized that the present housing accommodations in India is not satisfactory but also likely to get more 

worst due to the incredibly increasing population. The rapid industrial growth and population explosion have given rise to acute 

housing shortage, especially in urban and metropolitan areas. Increasing cost of the land and the need for proximity between the 

house and the work place in the view of the rising transport costs, have made multi-storyed building as a appropriate solution to 

overcome housing problems to an extent. The construction of the high rise buildings has become possible because of the recent 

advances in the design and construction technology coupled with innovative materials for providing service. 

1.1CLASSIFICATION OF MULTI-STOREYED BUILDINGS: 

Multi-storeyed buildings can be of the following types: 

1) Load bearing construction. 

2) Composite construction. 

3) Framed construction. 

Load bearing construction is economical only upto 2-3 storey. Composite construction, a combination of both load bearing and 

framed construction, is economical upto 5 storey. For 6 or more storey, it is necessary dealt with the framed construction. 

1.2ADVANTAGES OF FRAMED CONSTRUCTION: 

1) Dead load on foundations will be less due to reduction in wall thickness. 

2) Rate of construction is faster. 

3) Floor area will be more due to reduction on thickness of wall. 

4) Greater feasibility in respect of location and size of windows. 

5) The increased ability to resist lateral loads due to the rigidity of beams column connections.       

 

CHAPTER -2 

MODELLING OF STRUCTURE: 

 

2.1SOFTWARE SYNOPSIS; 

Modeling tools and templates, code-based load prescriptions, analysis procedures and solution techniques, all coordinate with the 

grid-like geometry exclusive to this class of structure. Basic or radical systems under static or dynamic conditions may be assessed 

using ETABS. For  a sophisticated assessment of seismic performance, modal and direct-integration time-history investigates 

may couple with P-Delta and Large Displacement effects. Nonlinear links and concentrated PMM or fiber hinges may capture 

material nonlinearity under monotonic or hysteretic behavior. Intuitive and united sorts so buses of any complexity useful to 

appliance. ETABS categories persuasive and totally integrated basics for plan of equally steel and reinforced concrete structures. 

The program affords the manipulator with selections to generate, adapt, consider and plan  structural models, all from within the 

similar operator interface. The program delivers cooperating atmosphere in which the operator can revise the stress conditions, 

sort appropriate deviations, such as revising member properties, and re-examine the results short of the essential to re-run the 

analysis. The yield in together graphical and tabulated presentations can be gladly printed. In this project seismic analysis of six 

dissimilar models is evaluated using E-TABS- 2015. The assessments of outcomes are in terms of storey displacement, Storey 

drift, lateral forces, Fundamental Time period, storey shear, modes shapes etc. 

 

2.2Procedure For Structural Modelling In E- Tabs Is Given Below: 

Step1: Laying Of Model With Template 

Step: 1.1: 

Select Start New Model using Template and select “Use Built-In Settings with” and select 

Display Units  : Metric SI Steel Section Data Base : Indian 

Steel Design Code  : IS 800:2007 Concrete Design Code : IS 456:2000 
 

Step 1.2: Enter the Grid and Story Dimensions in storey data sheet and click on Custom Grid Spacing then Click on Edit Grid Data 
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Observing story and grid system data as shown in fig above; Plan Grid layout and 3D layout of model are created as shown in 

figure below; 

 
STEP 2: DEFINE MATERIAL PROPERTIES 

Step 2.1:Define >> Material Properties >> Add New Material 

Enter the details as shown in figure below for Concrete then click on “OK”. 

 
 

Step 2.2: 

Define >> Material Properties >> Add New Material 

Enter the details as shown in figure below for Rebar then  click on “OK”. 
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STEP 3: DEFINE SECTION PROPERTIES 

Step 3.1: Defining of Beam Property 

Define >> Section Properties >> Frame Sections >> Add New Property 

 
Enter the Column section properties as shown in figure below and click on “Modify/show Rebar” to enter reinforcement details 

for Column as shown in figure below then click on “OK” 

 

Step 3.3: 

Define of Slab Property 

Define >> Section Properties >> Slab Sections >> Add New Property 

Specify slab section properties as shown in figure below; 

 

Step 3.4: Define of Shear wall: 

Define >> Section Properties >> Wall Sections >> Add New Property 

Enter the Shear Wall section properties as shown in figure below and click on “OK 

 

        

 

 

 

 

 

 

 

 

STEP4: DRAWING OF COLUMNS /BEAMS /SLABS/ SHEAR WALL: 

Step 4.1: Placing & Orientation of Columns 

Draw >> Draw Beam/Column/Brace Objects >> Quick Draw Columns (Plan, 3D) 

Select the property type of column and place the columns where ever necessary according their Orientation, Properties, Shape 

as shown in below figure, 
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Placed columns are shown below; 

 

 

Step 4.2: Drawing of Beam 

Draw >> Draw Beam/Column/Brace Objects >> Quick Draw Beams/Columns (Elev,Plan,3D) 

Select the property type of Beam (Ex: B300x450) and Place them where ever necessary according as shown in  below figure 

Drawn Beams are shown in below figure: 

 

 
 

Step 4.3: Drawing of Slabs 

Draw >> Draw Floor/Wall Objects >> Quick Draw Floor/Wall (Plan, Elev) 

Select the property type of Slab (EX. S125MM) and Place them where ever necessary according as shown in below figure: 

 
Drawn Slabs are shown in below figure: 
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Step 4.4: Go to the “Base Plan” and select all the slabs and Delete them and see that modify storey is kept to  “One Storey” 

only. 

 

 

STEP 5: ASSIGNING OF SUPPORTS: 

Go to the “Base Plan” and select all the joints and Go to Assign >>Joint >> Restraints >> Select Fixed Support >> Apply >> 

Ok 

 

 

STEP6:RELEASING OF PARTIAL FIXITY OF MEMBERS 

Go to the “Storey Plan 1” and “Storey Plan 2” and select the frames and Go to 

Assign >> Frame >> Releases/Partial Fixity >> Release At Start/End >> Apply Ok 

CHECK: Analyze >> Check Model >> Select All >>Ok 

See that there are warning message is displayed and if so move on to next step. 

 

STEP 7: DEFINING OF LOAD PATTERNS 

The Dead Load and Live Load are auto defined, if not define them and define Superimposed dead load as below 

Step 7.1: Defining of SIDL: 

Define >> Load Pattern >> SIDL >> Super Dead >> Multiplier “0” >> Add New Load >> Ok 

Step 7.2: Defining of  Earthquake Loads: Step 7.2.1: Earthquake Load in X –Direction. 

Define >> Load Pattern >> EQX >> Seismic >> Multiplier “0” >>select Auto lateral Load as IS 1893 2002 >>Click on Add 

New Load >> Ok 

Select EQX >>Click on Modify Lateral Load Indirection& Eccentricity Box select only X-Direction and Deselect all 

Step 7.2.2: Earthquake Load in Y –Direction 

Define >> Load Pattern >> EQY >> Seismic >> Multiplier “0” >>select Auto lateral Load as IS 1893 2002 >>Click on Add 

New Load>> Ok 

Select EQY >>Click on Modify Lateral Load Indirection& Eccentricity Box select only Y-Direction and Deselect all 
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STEP 8: ASSIGNING OF LOADS 

Step 8.1: Assigning of Loads to Shell Sections Step 8.1.1: For Live Load 

Go to Select >> Properties >> Slab Sections >> S125MM 

>> Close 

 

 
Go to Assign>> Shell Loads >> Uniform >> Shell Load Assignment 

Enter the details as shown below for Live Load: Load Pattern Name : Select Live 

Load : Enter 3Kn/m² 

Load Direction : Gravity 

Select  Replace  to Existing/Add to Existing.>>Apply >> Ok 

 
 

Step 8.1.2: For Super Imposed Dead Load 

Go to Select >> Properties >> Slab Sections >> S125MM 

>> Close 

 

 
 

 

GO to Assign>> Shell Loads >> Uniform >> Shell Load Assignment 

Enter the details as shown below for Superimposed Dead Load: 

Load Pattern Name : Select SIDL 

Load : Enter 1KN/m² 

Load Direction : Gravity 

Select Replace to Existing/Add to Existing>>Apply >>OK 
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Step 8.2: Assigning of Loads to Frame Sections Step 8.2.1: For Live Load 

Go to Select >> Properties >> Frame Sections >> B300X450 >> Close 

 

 

Go to Assign>> Frame Loads >> Distributed >> Frame Load Assignment 

Enter the details as shown below for Superimposed 

Dead Load: 

Load Pattern Name : Select Wall Load Load Type  :   Forces Load Direction : Gravity 

Uniform Load :  Enter 12.5Kn/m² Select Replace to Existing/Add to Existing.>>Apply >> Ok 

STEP 9: LOAD COMBINATIONS 

Go to Define>> Load Combinations >>Select Add Default Design Combination >>Select Concrete Frame Design >> OK 

STEP 10: Define of Mass Source: 

Go to Define>>Define>>Select Mass Source>>Select Add New Mass Source. 

Enter the details as shown: 

Mass Source Name: MS Src2, 

Mass Multipliers for Load Patterns: Add: Load Pattern: Dead, Multiplier: 1 

Add: Load Pattern: SIDL, Multiplier: 1 Add: Load Pattern: Live, Multiplier: 0.25 
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Change default mass source to MsSrc2 and Select the previous mass source and delete it. 

 

STEP 11: DIAPHRAGM ASSIGNING 

Go to Select >> Object Type >> Floors 

Go to Define>> Assign >> Shell >> select Diaphragms 

>>select D1 >> Apply >> OK. 

 

 

STEP 12: MODEL ANALYSING 

Go to Analyze >>Select Set Load Cases To Run >> Run Now >> OK 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Run analysis from Analysis > Run Analysis command 
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CHECK ANALYSIS >> check model >>select all >> ok 

See that are warning message is displayed 

BUILDING MODELS DESCRIPTION 

MODEL 1: 

It is the bare frame model in which the weights of the masonry wall of 230mm thick have been assigned on all over the beams. 

The above procedure has been analyzed for Model 1. 

MODEL 2: 

This model is same as Model 1 in addition the extreme corner columns of ground storey have been removed or floated. 

The following procedure will analyze the Model 2: 

i) Open the ETABS Program 

ii)Click the File menu >Open > MODEL 1 

iii) Set the main window to Elevation View 

iv) Remove the Corner Columns to Float from Base Story 

v) Select the Floating Columns > Assign > Frame > 

Releases/Partial Fixity >OK 

to assign fixed support 

vi) Go to Select > Object Type > Floors > 

Go to Define> Assign >Shell > Select Diaphragms >Select D1 >> Apply >> OK. 

vii) Go to Analyze > Check Model 

viii) Go to Analyze > Run 

ix) Save the MODEL 1 file to Save As (MODEL 2). The following figures have been resultant from E-tabs. 

 
 

CHAPTER-3 

DESIGNS: 

The main criteria for the design are: 

1) SAFETY 

2) SERVICE ABILITY 

3) DURABILITY 

4) ECONOMY 

 The main components are structural analysis and structural design. Structural analysis deals with the development of 

suitable arrangement of structural elements for the structures to support the external loads. It deals with the internal forces, external 

reactions, state of stresses etc. Structural Design deals with the selection of the proper shape, size of members and the material to 

be used. 

3.1DESIGN PHILOSOPHIES 

3.1.1METHODS OF DESIGN: 

Some of the popular design methods are: 
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1) Working Stress Method. 

2) Ultimate Load Method. 

3) Limit State Method. 

3.2WORKING STRESS METHOD: 

 This is also known as MODULAR RATIO METHOD, F.O.S. METHOD and ELASTIC METHOD. 

 In this method, analysis is based on the elastic theory assuming that both materials obey Hook’s Law. It is a traditional 

method which is used for the design of reinforced concrete design where it is assumed that concrete and steel act together and are 

perfectly elastic at all stages and relationship between the loads and stresses is linear upto the collapse of the structure. It is based 

on the criteria that the actual stresses developed in the material under the action of the working loads is limited to a set of allowable 

values. Thus, the sections are designed in such a way that the stresses are within the permissible limits. This leads to         un-

economical sections, as the method doesn’t utilize the full strength of the material resulting in heavier sections. 

Design Loads            = working /service loads. 

Design Stresses        = characteristic values /F.O.S 

DEFECTS: 

1) It neither shows its real strength nor gives true factor of safety of structure against failure. 

2) It results in larger % of compressive steels then limit state design.         

3.3ULTIMATE LOAD METHOD: 

This is also known as LOAD FACTOR METHOD. 

 In this method, inelastic behavior of concrete is taken into account. At the failure the material tends to behave elastically, 

the strain increases many times beyond those in the elastic theory and stress distribution adjusts itself to enable member to develop 

maximum capacity. In this method, service loads are proportioning the section to carry upto the ultimate strength of the material. 

Design Load        =   Working load * load factor 

Design Stress      = characteristic value / Load factor. 

Load Factor        = 1.5 ----- Concrete 

                            = 1.15 ----- Steel. 

DEFECTS: 

 This method gives slender sections but larger deflections and larger cracks. Thus, in this method serviceability is not 

taken care off. 

3.4LIMIT STATE DESIGN: 

 It is an ideal method of design which takes into consideration not only ultimate strength but also serviceability and 

durability requirement. It includes merits of both elastic and ultimate theories. When a structure or apart of the structure becomes 

unfit for It is said to have reached its “LIMIT STATE”. This method is to provide an acceptable probability that the structure will 

not reach any limit state during its services life time. 

 Design loads    = working loads * P.S.F. 

 Design stress   = characteristic values/ P.S.F. 

         P.S.F. depends on the load combinations as per 36.4.1, IS-456-2000. 

      It consists of:Limit state of collapse. 

1) Limit state of serviceability. 

3.5LIMIT STATE OF COLLAPSE: 

It is the limit state on attainment of which the structure is likely to collapse. It relates to strength and stability of the structures. 

Design to this limit ensures safety of structure against collapse. 

Limit state of collapse includes: 

1) Bending 

2) Shear 

3) Compression 

4) Torsion 

3.6LIMIT STATE OF SERVICEABILITY: 

It relates to performance and behavior of structure at working loads and is based on causes affecting serviceability of the structure. 

It concerns with cracking and deflection of the structure. 

  Limit state of serviceability includes: 

1) Deflections 

2) Vibrations 

3) Cracking 

4) Durability 

3.7ASSUMPTIONS IN DESIGN 

1. Partial safety factor, Ym for material, in accordance with clause 36.4.2., of IS-    456-    2000 is 1.5 for concrete and 

1.15 for steel. 

2. Using partial safety factors for loads in accordance with clause 36.4 of IS-456-2000 as Yf= 1.5 

3. Using partial safety factors in accordance with clause 36.4 of IS-456-2000 combination of loads. 
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D.L. + L.L.     =    1.5 

D.L. + L.L. +W.L.    =     1.2 

 

3.7.1LIVE LOADS: (In accordance of I.S. 875-1978) 

i) Live load for residential buildings   =  2.0 KN/m² 

ii) Live loads for commercial buildings =  3.0 KN/m² 

iii) Live loads for corridors, staircases,    =  3.0  KN/m² balconies, etc. 

3.7.2 MATERIAL DENSITIES: 

1) Plain cement concrete                =  24 KN/m³ 

2) Reinforced cement concrete       =  25  KN/m³ 

3) Floor finishes                               =  1 KN/m³ 

4) Brick masonry                              =  20 KN/m³ 

 

3.7.3ASSSUMPTIONS FOR DESIGN: 

1) Slab is assumed to be continuous over internal supports and partially fixed on edges, due to monolithic construction 

&due to construction of walls over it. 

2) Beams are assumed to be continuous over interior support. 

 

3.8WIND EFFECTS ON STRUCTURE: 

Strictly speaking all structures will experience dynamic oscillations due to the fluctuating component (gustiness) of wind. In short 

rigid structures these oscillations are insignificant, and therefore can be satisfactorily treated as having an equivalent static 

pressure. This is the approach taken by most Codes and Standards, as is also the case in this Standard. The more flexible systems 

such as tall buildings undergo a dynamic response to the gustiness of wind. Methods for computing the dynamic effect of wind 

on buildings have been introduced in this Standard. Apart from tall buildings there are several other structural forms (though 

outside the scope of this Standard) such as tall latticed towers, chimneys, guyed masts that need to be examined for aerodynamic 

effects. – Wind is not a steady phenomenon due to natural turbulence. However, when averaged over a sufficiently long time 

duration (from a few minutes to an hour), a mean component of wind speed can be defined which would produce a static force 

on a structure. Superimposed on the mean/static component is the time varying component having multiple frequencies spread 

over a wide band.This Code also applies to buildings or other structures during erection/ construction and the same shall be 

considered carefully during various stages of erection/construction. In locations where the strongest winds and icing may occur 

simultaneously, loads on structural members, cables and ropes shall be calculated by assuming an ice covering – The construction 

period of a structure is much smaller than its expected life. Therefore, a smaller return period of 5 to 10 years or longer may be 

considered for arriving at the design factor (factor k1) for construction stages/period of a structure depending on its importance. 

In snowfall areas where icing occurs, wind loads have to be considered. 

3.9DESIGN PHILOSOPHY FOR BUILDING SUBJECTED TO WIND LOADS 

Wind load on structures is affected by: 

1. Wind speed and gust effect 

2. Height and stiffness of building 

3. Cross-sectional shape of building 

4. Surrounding topography and terrain 

5. Presence of openings in the building envelope 

IS: 875(part 3):1987 specifies the wind velocity pressure at any height above mean ground level  

Wind Pressure (PZ): the wind pressure at any height above mean ground level shall be obtained by the following relationship 

between wind pressure and wind Speed. 

PZ = 0.6 VZ
2 

Where PZ = wind pressure in N/m2   at height z, 

VZ = design wind Speed in m/s at height z 

Design Wind Speed (Vz): the basic wind speed (Vb) for any site shall be obtained .and shall be modified to include the following 

effects to get design wind speed, (Vz) at any height, z for the chosen structure. 

 (a) Risk level, 

 (b) Terrain roughness and height of structure,  

 (c) Local topography 

 

3.10DESIGN PHILOSOPHY OF WIND LOADS ON THE TALL BUILDING: 

Buildings are defined as structures utilized by the people as shelter for living, working or storage. As now a days there is shortage 

of land for building more buildings at faster growth in both residential and industrial areas the vertical construction is given due 

importance because of which Tall Buildings are being built on a large scale. Wind in general has two main effects on the Tall 

buildings:-Firstly it exerts forces and moments on the structure and its cladding. Secondly it distributes the air in and around the 

building mainly termed as Wind Pressure Sometimes because of unpredictable nature of wind it takes so devastating form during 
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some Wind Storms that it can upset the internal ventilation system when impasses into the building. For these reasons the study 

of air -flow is becoming integral with the planning a building and its environment. 

Wind forces are studied on four main groups of building structures:-   

1. Tall Buildings 

2. Low Buildings  

3. Equal-Sided Block Buildings 

4. Roofs and Cladding  

Almost no investigations are made in the first two categories as the structure failures are rare, even the roofing and the cladding 

designs are not carefully designed, and localized wind pressures and suctions are receiving more attention. But as Tall buildings 

are flexible and are susceptible to vibrate at high wind speeds in all the three directions(x, y, and z) and even the building codes 

do not incorporate the expected maximum wind speed for the life of the building and does not consider the high local suctions 

which cause the first damage. Due to all these facts the Wind Load estimation for Tall Buildings are very much important. 

Wind engineering analyzes effects of wind in the natural and the built environment and studies the possible damage, 

inconvenience or benefits which may result from wind. In the field of structural engineering it includes strong winds, which may 

cause discomfort, as well as extreme winds, such as in a tornado, hurricane or heavy storm, which may cause widespread 

destruction. In the fields of wind energy and air pollution it also includes low and moderate winds as these are relevant to electricity 

production resp. dispersion of contaminants. 

Wind engineering draws upon meteorology, fluid dynamics, mechanics, geographic information systems and a number of 

specialist engineering disciplines including aerodynamics, and structural dynamics. The tools used include atmospheric models, 

atmospheric boundary layer wind tunnels, open jet facilities and computational fluid dynamics models, wind engineering involves 

other topics such as: 

1. Wind impact on structures (buildings, bridges, towers). 

2. Wind comfort near buildings. 

3. Effects of wind on the ventilation system in a building. 

4. Wind climate for wind energy. 

5. Air pollution near buildings. 

The advent of high rise towel blocks led to concerns regarding the wind nuisance caused by these buildings to pedestrians in their 

vicinity. A number of wind comfort and wind danger criteria were developed from 1971, based on different pedestrian activities 

such as:  

1. Sitting for a long period of time 

2. Sitting for a short period of time 

3. Strolling 

4. Walking fast 

Other criteria classified a wind environment as completely unacceptable or dangerous. Building geometries consisting of one and 

two rectangular buildings have a number of well-known effects:  

1. Corner streams, also known as corner jets, around the corners of buildings 

Through-flow, also known as a passage jet, in any passage through a building or small      gap between two buildings due to 

pressure short-circuiting 

2. Vortex shedding in the wake of buildings 

For more complex geometries, pedestrian wind comfort studies are required. These can use an appropriately scaled model in a 

boundary layer wind tunnel, or more recently there has been increased use of computational fluid dynamics (CFD) techniques. 

The pedestrian level wind speeds for a given exceedance probability are calculated to allow for regional wind speeds statistics. 

The vertical wind profile used in these studies varies according to the terrain in the vicinity of the buildings (which is may differ 

by wind direction), and is often grouped in categories such as 

1. Exposed open terrain with few or no obstructions and water surfaces at serviceability wind speeds. 

2. Water surfaces, open terrain, grassland with few, well-scattered obstructions having heights generally from 1.5 m to 

10m. 

3. Terrain with numerous closely spaced obstructions 3 m to 5 m high, such as areas of suburban housing. 

4. Terrain with numerous large, high (10 m to 30 m high) and closely spaced obstructions, such as large city and well-

developed industrial complexes.                      

 

 

International Journal of Engineering Research & Technology (IJERT)

ISSN: 2278-0181http://www.ijert.org

IJERTV9IS030136
(This work is licensed under a Creative Commons Attribution 4.0 International License.)

Published by :

www.ijert.org

Vol. 9 Issue 03, March-2020

105

www.ijert.org
www.ijert.org
www.ijert.org


 
 

CHAPTER-4 

4.1SPECIFICATIONS OF CONSTRUCTION 

 

1. STRUCTURE    :   R.C. FRAMED STRUCTURE 

 

2. SUPER STRUCTURE  : Burnt clay bricks in mortar cement                          

3. MAIN DOOR    : Best Teak wood polished frame and shutter 

                                              With standard fittings. 

4. OTHER DOORS             : Best teak wood frames and teak veneer  

                                          Flush shutters with standard fittings. 

5. WINDOWS    : Best teak wood frames and polished teak 

                                            Wood glazed shutters. 

6. PLASTERING   : Sponge finish with cement mortar in two            

                                                              Coats.                                                      

7. FLOORING    : Marble flooring. 

 

8. KITCHEN               : polished granite cooking platform&     

                                               Granite tile dado upto 0.6m height and  

                                                Sink will be provided. 

9. TOILETS               :  ceramic tile flooring, tile dado upto 1.8 m  

                                             Height. One Indian and one Egyptian water 

                        Closet with good sanitary fittings. 

10. PAINTINGS    : Altek finishing for all the rooms with O.B.D 

  Paints and external snow cement. 

 

11. ELECTRIFICATION              :  concealed wiring with sufficient light point 

 

12. LIFT     :  6 persons capacity passenger lifts of 

   Standard make will be provided. 

13. GENERATOR   :  Generator for lift, bore well mortar, lighting 

For corridor & other common areas provided.    

 

CHAPTER-5 

PLAN 

Plans are a set of drawings or two-dimensional diagrams used to describe a plan or object, or to communicate building or 

fabrication instruction. Usually plans are drawn or printed on paper, but they can take the form of a digital file. 

A plan is a view of a 3-dimensional object from the position of a horizontal plane through, above, or below the object. In such 

views, the portion of the object in front of the plane is omitted to reveal what lies beyond. In the case of a floor plan, the roof and 

upper portion of the walls may be omitted. Elevations, top (roof) plans, and bottom plans are orthographic projections, but they 

are not sections as their viewing plane is outside of the object. 

A plan is a common method of depicting the internal arrangement of a 3-dimensional object in two dimensions. It is often used 

in technical drawings and is traditionally cross-hatched. The style of crosshatching indicates the type of material the section passes 

through.  

5.1 FLOOR PLAN: 

In architecture and building engineering, a floor plan otherwise known as the Scottish plan, plan is a drawing to scale, showing a 

view from above, of the relationships between rooms, spaces, and other physical features at one level of a structure. 

It is also called a plan which is a measured plan typically projected at the floor height of 4 ft (1.2m), as supposed to an elevation 

which is a measured plane projected from the side of a building, along its height, or a section or cross section where a building, 

is cut along an axis to reveal the interior structure. 

5.2ELEVATION: 

An elevation is a view of a 3-dimensional object from the position of a vertical plane beside an object. In other words, an elevation 

is a side-view as viewed from the front, back, left or right. It is the corollary to the concept of a “view” (which is always overhead 

and is therefore referred to as an overhead view). 
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Elevations are the most common orthographic projection for conveying the appearance of a building from the exterior. 

Perspectives are also commonly used for this purpose. A building elevation is typically labeled in relation to the compass direction 

it faces the direction from which a person views it. E.g. the SOUTH ELEVATION of a building is the side that most closely faces 

true south on the compass. 

 5.3SUMMARY ON PLAN: 

1. In this chapter the plan shows the detail dimensions of each and every room and the type   of room and orientation 

of the different rooms like drawing room, living room, bathroom, toilet, etc. All floors have similar room arrangements. 

2. The plan also gives the details of location of staircase in the building and the type of staircase. This plan consists of 

Open-well type of staircase. 

3. Lift section is also represented in the plan. The building consists of one lift and those who want to go upper floors can 

use the lift. Any building with more than G+3 floors should compulsory keep lift facility. 

 

CHAPTER-6 

SLABS 

Slabs are plain structural members forming floors and roofs of building whose thickness is quite small compared to other 

dimensions. As thickness of slab is very less, design criteria are deflections. 

As per IS Code deflection criteria is checked by ASPECT RATIO. 

6.1CLASSIFICATION OF SLABS: 

A Slab may be simply supported or continuous over one or more supports and classified as: 

1) One way slab spanning in one direction. 

2) Two way slab spanning in two directions. 

3) Circular slabs 

4) Flat slabs resting directly on columns with no beams 

5) Grid slabs 

6) Ribbed slabs 

6.2ONE WAY SLAB: 

   Longer side/shorter side > 2 

R.C.C. slabs with supports on longer edges only and free of any support in shorter direction are called as one- way slabs. It is 

called one way slab because most of load is carried along shorter direction even if supports are provided in all the four sides. 

Bending direction is shorter direction and effective span is the shorter direction. 

         These slabs area analyzed and designed similar to width as one meter. The curvature and bending moment are same in all 

directions in the shorter direction between the supported sides and in the longer direction they remain zero.  
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6.2.1Reinforcement: 

Main reinforcement is placed parallel to shorter direction. 

Distribution reinforcement is provided in longer direction. 

Purpose of distribution reinforcement: 

1) To resist temperature changes, shrinkages, etc.  

2) To distribute loads/stresses uniformly. 

3) To hold the main reinforcement. 

6.3TWO WAY SLABS: 

   Longer side/shorter side <= 2 

 R.C.C. slabs supported on all the four sides are called as two way slabs. They are called two- way one way slab for 

similar load and support conditions. Thus, the thickness of a two way designed slab should be smaller than that of a designed one 

way slab. Thus, two-way slabs are more economical.  

 
 

Two-way slabs are further divided into 2 types: 

1. Restrained slabs 

2. Simply supported slabs. 

6.4RESTRAINED SLABS: 

The corners of a two-way slab have a tendency to lift. When the corners are prevented from lifting, the slab is called restrained 

slab. In restrained slabs, maximum bending moment and deflections are smaller than simply supported slabs whose corners are 

not held down. For these slabs, it is essential to provide adequate provisions to resist torsion at corners. 

 The simply supported edges do not resist any bending moment and permit free rotations. Such slab edges are referred as 

Discontinuous edges. The fixed edges resist bending moment and do not allow rotations. The continuous support also resist 
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bending moment and at a continuous edge, rotations occur but are equal and of opposite sign at a common support. Thus, fixed 

and continuous supports are referred as Continuous Edges. Two-way slabs are classified depending on continuity and 

discontinuity of longer and shorter edges into nine standard cases. 

6.5 I.S. Code Design Method: 

In accordance with clause D.1.1 of IS 456-2000, Appendix ‘D’ 

Maximum B.M. along X and Y direction are 

    Mx    = αx*W*Lx²  

    My    =  αy*W*Lx²  

Where, 

αx, αy are coefficients given in table 26 of IS 456-2000 for different ratios of Ly/Lx and condition of  different fixed edges. 

Reinforcement: 

In case of fixed slab, main steel required to resist sagging moment is required only between points of contra-flexures. Code based 

on experimental studies has given middle strips (
3∗𝐿

4
 ) which has tension on bottom face. Therefore the slab is divided is divided 

into edge strips ( 
1∗𝐿

8
 ) and middle stripS ( 

3∗𝐿

4
 )  

 6.6CANTILEVER SLAB: 

Cantilever slabs are commonly used for chejjas and balconies projecting from the wall from lintel beams or floor slabs. These 

slabs are free at one end and may be treated as fixed at the supporting end. They need the reinforcement at top layers since tension 

develops in top layers. 

The bending moment is maximum at the fixed end and it reduces to zero at the free end hence the thickness of cantilever slab may 

be reduced gradually towards the free end to minimum depth. 

In the design of cantilever slab, the following points are to be noted. 

For uniformly distributed loads, the bending moment and shear force is 

𝑀𝑢 =
𝑤𝑙2

2
 

𝑉𝑢 = 𝑤 × 𝑙 
Basic value of span to depth ratio for cantilevers = 7. 

To find the trial depth, 
𝑙

𝑑
ratio may be taken as 10 taking the modification factors into consideration. 

Main bars to be provided at the top and distribution bars are to be provided in the transverse direction. 

They should be check for anchorage length of main bars at the support. 

 6.7GENERAL DESIGN REQUIREMENTS FOR SLABS AS PER IS 456-2000: 

1. Effective Span: The effective span of a simply supported slab shall be taken as clear span plus effective depth of the slab or 

center to center distance between the supports whichever is less. 

  

The effective span of a cantilever slab shall be taken as its length to the face of the support plus half the effective depth except 

where it forms the end of a continuous slab where the length to the center of support shall be taken. 

  

2. Limiting Stiffness: The stiffness of slabs is governed by the span to depth ratio. As per Clause 23.2 of IS 456 for spans not 

exceeding 10 m, the span to depth ratio (basic values) should not exceed the limits given below. 

  

Cantilevers              — 7 

Simply supported   — 20 

Continuous             — 26 

  

Depending upon the type of steel and percentage of steel, the above values have to be modified as per Fig.4 of IS-456. 

   

For two way slabs, the shorter span should be used for calculating the span to effective 2 depth ratio. 

  

3. Minimum Reinforcement: The reinforcement in either direction of span shall not be less than 0.15 % of gross cross sectional 

area if mild steel is used. However, this value is reduced to 0.12 % where high strength deformed bars or welded wire fabrics 

are used. (Clause 26.5.2.1 of IS-456) 

  

4. Maximum Diameter of Bars: The diameter of the bars shall not exceed one eighth of the total thickness of slab. (Clause 

26.5.2.2 of 15-456). 

 

5. Spacing of Main Reinforcement: The spacing of main reinforcement in slabs shall not be more than three times the effective 

depth of solid slab or 300 mm whichever is less. (Clause 26.3.3 of 15-456) 

  

6. Distribution Reinforcement: The area of distribution reinforcement shall not be less than 0.15% of gross cross sectional area 
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if plain bars are used and 0.12% if high yield strength deformed bars are used. The spacing of distribution reinforcement in slabs 

shall not be more than five times the effective depth of slab or 450 mm whichever is less. 

  

7. Cover to Reinforcement: Reinforcement shall have concrete cover of thickness as follows.  

 

(a)At each end of reinforcement bar neither less than 25 mm nor less than twice the diameter of such bar. 

(b)The bottom cover for reinforcement shall neither be less than 20 mm nor less than the diameter of such bars 

 

6.8DESIGN OF SLAB (TYPICAL FLOOR) (S10) (ONE WASLAB) 

DESIGN OF SLABS (ONE WAY)        

STEP1:- PRELIMINARY DATA 

               LY = 4.95 M      

               LX = 1.M      

LY/LX=2.565M      

CONDITION:  ONE - WAY SLAB       

END CONDITION one long edge continuous      

Grade of concrete - M20      

Grade of steel       - Fe500         

Assuming overall thickness of slab as       

D= 115mm      

Clear cover: -                    d'=   20mm      

Diameter of the bar 10mm Assumed 

Effective depth of slab     d=  90mm          

STEP 2:- LOAD CALCULATION        

1) Self weight of slab   = 2.875 kn/m2      

2) Floor finish              = 1 kn/m2      

    Total dead load        = 3.875 kn/m2 

3) Live load                 = 3 kn/m2 

    Total load                = 6.875 kn/m2      

Factored load,    w = 10.3125kn/m2   

     

STEP 3:- BENDING MOMENT CALCULATION     

For ly/lx= 2.565           

For one way slab the maximum bending moment      

B.M= WLx
2/10          

3.841303125Kn-m      3841303.125N-mm 

    

STEP4:- CHECK FOR DEPTH 

       

d= (M/(R*b)) 2  R=0.134*20=2.67   for M20    

b= 1000mm           

d= 37.93  

      

HENCE SAFE   

        

STEP5:   AREA OF STEEL REINFORCEMENT 

    

AST=(0.5*FCK)/FY(1-SQRT(1-(4.6*M)/FCK*b*d2)b*d   

AST =101.00mm2         

Minimum AST= 0.12% of Gross Cross-Sectional Area    

 0.12%*b*D       

Minimum AST= 138mm2 

        

STEP6:- CALCULATION OF SPACING 

      

FOR SHORTER DIRECTION        

Required ASTx=max of AST and ASTmin      

HENCE 138.00 mm2 

 

Spacing s= AØ/AST *1000 
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Assume  10mm Ø bars     

 AØ = 78.540 mm2     

Spacing s=569.13mm          
Maximum spacing:-It should not be greater than 3d or 300mm whichever is less   3d= 270  

    

 Hence provide 10mm Ø@ 150 mm c/c in shorter direction    

FOR LONGER DIRECTION        

Required AST= ASTmin 

HENCE 138.00 mm2         

Assume  8mm Ø bars     

 AØ = 50.265 mm2     

Spacing s= 364.24mm        

Maximum spacing:-It should not be greater than 3d or 300mm whichever is less   

 3d=270mm     

 Hence provide 8mm Ø@ 150mm c/c in longer direction    

STEP:-7 CHECK FOR DEFLECTION       

 Lx/αd   < 32          

α   is the Modification Factor obtained from fig4 IS-456-2000 #PG NO:- 38  Fs=0.58*fy*(AST required/AST 

provided)   

AST provided= (AØ/spacing provided) *1000  

 

AØ = 78.540 mm2     

 

Spacing provided whichever is less from above calculation i.e. longer and shorter direction  

 

AST provided= 523.60mm2        

 

Fs=76.43 N/mm2   

 

PERCENTAGE OF REINFORCEMENT PROVIDED  

   

Pt= (AST provided/b*d)*100        

Pt=0.581776          

 For Fs=76.43 N/mm2, pt= 0.58       

Therefore α value from fig#4 pg. no: 38 in IS-456-2000     

 α=2      

Therefore            

Lx/αd =10.722  

 Lx/αd < 32     

 SAFE.   

 

6.9DESIGN OF SLABS (two way) Typical Floor (S3)  

STEP1:- PRELIMINARY DATA        

LY=6.22M      

LX=3.87M      

LY/LX=1.607M      

CONDITION TWO WAY SLAB       

END CONDITION two adjacent edges discontinuous    

Grade of concrete  M20      

Grade of steel Fe 500         

Assuming overall thickness of slab as       

D =115mm      

Clear cover:-  d'=20mm      

Diameter of the bar10mm    Assumed     

Effective depth of slab        

d= 90mm        

STEP 2:- LOAD CALCULATION        

1) Self weight of slab = 2.875 KN/m2      

2) Floor finish= 1 KN/m2      

Total dead load 3.875 KN/m2      
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3) Live load= 2 KN/m2        

Total load 5.875 KN/m2      

Factored load,    w =8.8125KN/m2  

 

STEP 3:- BENDING MOMENT CALCULATION 

           For ly/lx=   1.607                                                                                                      Reference pgno#91 in IS-456 

-2000 for two adjacent edges discoutinuous   

BENDING MOMENT COEFFICIENT       

Pgno#91 in IS-456 -2000; table no26   long span coefficient values  

 αxc  αyc     

1.5               0.075                                             0.047   

1.75           0.084       

1.6                0.08       

 αxm  αym     

1.5                 0.056                                            0.035    

1.75            0.063       

1.6                     0.0588          

Bending moment coefficients are        

αxc    0.08       

αxm 0.0588       

αyc  0.047       

αym 0.035       

BENDING MOMENTS are given by       

MXC=αxc.W.LX
2=10.29 KN-m               

MXM=αxM.W.LX
2 =7.76KN-m    

MYC=αYC.W.LX
2 =6.20KN-m    

MYM=αYM.W.LX
2 =4.62KN-m 

 

STEP4:- CHECK FOR DEPTH       

d= (M/(R*b))2     R=0.134*20=2.67  for M20   

  b=1000mm         

d= 62.09mm       

 HENCE SAFE         

STEP5:- AREA OF STEEL REINFORCEMENT    

AST=(0.5*FCK)/FY(1-SQRT(1-(4.6*M)/FCK*b*d^2)b*d    

AST XC 285.77 mm2      

AST XM 210.65 mm2      

AST YC 166.20 mm2      

AST YM 122.20 mm2         

Minimum AST= 0.12% of Gross Cross-Sectional Area    

 0.12%*b*D       

Minimum AST=138mm2         

STEP6:- CALCULATION OF SPACING      

FOR SHORTER DIRECTION        

Required ASTx=max of ASTxc, ASTxm and ASTmin     

HENCE 285.77mm2  condition   

Spacing s=AØ/AST *1000       

Assume  10mm Øbar’s     

 AØ =78.540mm2     

Spacing s=274.83mm   

       

Maximum spacing:-It should not be greater than 3d or 300mm whichever is less 

3d=270     

 Hence provide 10mm Ø@ 150 mm c/c in shorter direction    

FOR LONGER DIRECTION        

Required ASTy=max of ASTyc,ASTym and ASTmin     

HENCE 166.20mm2         

Assume  8mm  Øbar’s     

 AØ=50.26mm2     

Spacing s=350.35mm=350mm           
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Maximum spacing:-It should not be greater than 3d or 300mm whichever is less    3d=270  

  

 Hence provide 8mm Ø@ 200mm c/c in longer direction      

STEP:-7 CHECK FOR DEFLECTION      

 Lx/αd <_ 32         

α   is the Modification Factor obtained from fig4 IS-456-2000 #PG NO:- 38   

Fs=0.58*fy*(AST required/AST provided)       

AST provided= (AØ/spacing provided) *1000       

 AØ= 78.540mm2     

Spacing provided whichever is less from above calculation i.e. longer and shorter direction 

AST provided=523.6mm2  

Fs=158.28N/mm2   

       

PERCENTAGE OF REINFORCEMENT PROVIDED 

Pt= (AST provided/b*d)*100        

Pt=0.581776= 0.58         

For Fs=158 N/mm2  , pt= 0.58       

Therefore α value from fig#4 pg. no: 38 in IS-456-2000     

 α=1.8      

Therefore           

Lx/αd = 23.889  

 Lx/αd <32     

 SAFE       

    6.10 SLAB REINFORCEMENT DETAILS 

              Typical floor slab detailing  Ground floor roof  slab detailing 

 
 

NAME                  

OF 

SLAB 

 

TYPE  

   OF 

SLAB 

     

   D 

(mm) 

                MAIN REINFORCEMENT   

 

 

 

DISTRIBUTION 

REINFORCEMENT 

AstX(+ve) AstX(-ve) AstY(+ve) AstY(-ve) 

    

   S1 

 

TWO 

WAY 

 

115 

 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

        10mmØ bars 

@150mm c/c    

 

 

   S2 

 

0NE 

WAY 

 

115 

 

 

10mmØ bars    

@150mm c/c 

          __           __           __  

 8mmØ bars @150mm c/c 

 

   S3 

TWO 

WAY 

 

115 

 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

8mmØ bars 

@200mm c/c 

 

8mmØ bars 

@200mm c/c 

 

           __ 

 

   S4 

 

ONE 

WAY 

 

115 

 

 

10mmØ bars    

@150mm c/c 

__ __ __  

        8mmØ bars @150mm c/c    

 

   S5 

 

ONE 

WAY 

 

115 

 

10mmØ bars    

@150mm c/c 

__ __ __  

        8mmØ bars @150mm c/c    

 

   S6 

 

TWO 

WAY 

 

115 

 

10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
__ 

 

   S7 

 

TWO 

WAY 

 

115 

 

10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
__ 

 

   S8 

 

ONE 

WAY 

 

115 

 

10mmØ bars    

@150mm c/c 

 

        __ 

 

      __ 

 

          __ 

 

8mmØ bars @150mm c/c 

 

   S9 

 

ONE 

WAY 

 

115 

 

10mmØ bars    

@150mm c/c 

 
         __ 

 
      __ 

 __  

 

 

           8mmØ bars @150mm c/c 

 
 

NAME                  

OF 

SLAB 

 

TYPE  

   OF 

SLAB 

    

   D 

(mm) 

                 

                        MAIN  REINFORCEMENT                              

 

 

DISTRIBUTUITION 

REINFORCEMENT 
  Astx(+ve)   Astx(-ve) Asty(+ve) Asty(-ve) 

 

S10 

 

ONE 

WAY 

 

 

115 

 

10mmØ bars 

@150mm c/c 

 

      __ 

     

 

      __ 

 

        __ 

 

   8mmØ bars    @150mm c/c 
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NAME                  

OF 

SLAB 

 

TYPE  

   OF 

SLAB 

     

   D 

(mm) 

                MAIN REINFORCEMENT   

 

 

 

DISTRIBUTUITION 

REINFORCEMENT 

AstX(+ve) AstX(-ve) AstY(+ve) AstY(-ve) 

    

   S1 

 

TWO 

WAY 

 

115 

 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

        10mmØ bars 

@150mm c/c    

__ 

 

   S2 

 

TWO 

WAY 

 

115 

 

 

10mmØ bars    

@150mm c/c 

10mmØ bars 

@150mm c/c 

10mmØ bars 

@150mm c/c 

10mmØ bars 

@150mm c/c 

__ 

 

   S3 

TWO 

WAY 

 

115 

 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

10mmØ bars 

@150mm c/c 

 

           __ 

 

   S4 

 

ONE 

WAY 

 

115 

 

 

10mmØ bars    

@150mm c/c 

__ __ __  

        8mmØ bars @150mm c/c    

 

   S5 

 

TWO 

WAY 

 

115 

 

10mmØ bars    

@150mm c/c 

10mmØ bars 

@150mm c/c 

10mmØ bars 

@150mm c/c 

10mmØ bars 

@150mm c/c 

 

        8mmØ bars @150mm c/c    

 

   S6 

 

TWO 

WAY 

 

115 

 

10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
10mmØ bars 

@150mm c/c 
__ 
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CHAPTER-7 

STRUCTURAL ANALYSIS 

A structure refers to a body or system of connected parts used to support a load. Important examples related to Civil 

Engineering include buildings, bridges, and towers. 

Structural analysis is the determination of the effects of loads on physical structures and their components. Structures subject to 

this type of analysis include all that must withstand loads, such as buildings, bridges, vehicles, machinery, furniture, attire, soil 

strata, prostheses and biological tissue. Structural analysis employs the fields of applied mechanics, materials science and applied 

mathematics to compute a structure's deformations, internal forces, stresses, support reactions, accelerations, and stability. The 

results of the analysis are used to verify a structure's fitness for use, often precluding physical tests. Structural analysis is thus a 

key part of the engineering design of structures. 

After assigning the dimensions of the structural members it is necessary to assign the loads that the structure must support. 

7.1 LOADING CONSIDERATION: 

There are two types of loads that structure engineering must encounter in the design. First type of load is called Dead loads that 

consist of the weights of the various structural members and the weights of any objects that are permanently attached to the 

structure. For example, columns, beams, girders, the floor slab, roofing, walls, windows, plumbing, electrical fixtures, and other 

miscellaneous attachments.  

Second type of load is Live Loads which vary in their magnitude and location. There are many different types of live loads like 

building loads, highway bridge Loads, railroad bridge Loads, impact loads, wind loads, snow loads, earthquake loads, and other 

natural loads. 

The major gravity loads on building structures are dead and live loads and the major lateral loads on building structures are seismic 

and wind loads 

 

 

DEAD LOAD ON STRUCTUR 

 

 7.2LIVE LOAD OR IMPOSED LOAD 

Live loads are short duration forces which change in location and magnitude during the life of the structure. They include the 

weight of people, furniture and movable partitions. They are based upon intended use or occupancy of the building (e.g. residential 

versus office). Live load has two components: 
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(1) Sustained, which is less uncertain and acts over a long period (e.g. furniture) 

(2) Transient, which is more uncertain and acts over a short period (e.g. people) 

Live loads include adequate allowance for ordinary impact conditions. Weight of machinery and moving loads shall be increased 

for impact. 

Live load shall be assumed in accordance with IS 875 (part 2) : 1987 

Live Load (LL) = 2 KN                                  3 KN/m2 (commercial)  

 

LIVE LOADS ON STRUCTURE 

 

 

 

 

 

 

 

7.3STRESSES ACTING ON SLAB 

2D-VIEW 
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3D-VIEW 

 

 

BEAM AND COLUMN 

Beam dimensions are: (in meter)                        Columns dimensions :( in meter) 

  0.230 x 0.375                                                          0.30 x 0.30 

 

 

CHAPTER-8 

BEAMS 

BEAM is a horizontal structural member subjected to transverse loads. 

When load acts on the beam it bends. For a S.S.B., compression acts on the top fiber and tension in bottom fiber and vice versa 

for cantilever beam. 

Beam has 2 axes: 

4) Longitudinal axis 

5) Transverse axis 

In the cross-section if load is acting along the transverse axis, the beam is subjected to B.M., .S.F. only. 

If load is acting at some eccentricity with transverse axis, then beam is subjected to B.M., S.F. & Torsion. 

 i.e., B.M. is bending along the longitudinal axis 

         Torsion is about the longitudinal axis. 

8.1TYPE OF SECTIONS: 

6) Balanced section 

7) Under-reinforced section 

8) Over-reinforced section 
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8.1.1BALANCED SECTION: A section is said to be balanced when the compressive stress in concrete is balanced by tensile 

stress in steel. The stresses in concrete and steel reach to ultimate values at the same time. Practically, it is difficult to have a 

balanced section, but theoretically, all sections are designed as balanced. As per assumptions in Limit State of Collapse, the 

maximum strain in concrete at the outermost compression fiber at collapse, €cu is taken as 0.0035. 

    
𝑋𝑢

𝑑
 = 

0.0035

0.0035+€𝑠𝑦1
 

The limiting values of Xu are: 

5) For mild steel  - fy= 250 Mpa;    
𝑋𝑢 𝑚𝑎𝑥

𝑑
  =   0.53. 

 

6) For HYSD bars Fe₄₁₅ -         fy= 415 Mpa;    
𝑋𝑢 𝑚𝑎𝑥

𝑑
   =   0.48. 

 

4) For Fe500 bars                     -         fy= 500 Mpa ;    
𝑋𝑢 𝑚𝑎𝑥

𝑑
  = 0.46. 

 

Balanced sections can be designed using either of the equations: 

Mulim = 0.36*fck * b * Xumax * (d-0.42 Xumax)         ----------- (1) 

Mulim   = 0.87*fy * Ast * (d-0.42 Xumax)                    ----------- (2) 

                                                                        //Moment of resistance// 

8.2Under-Reinforced Sections: 

The steel in the section is lesser than that required for a balanced section. The strain in steel €sy1, while the strain in concrete €c 

remains still below the ultimate value (0.0035). The failure is in steel and thereby steel yields prior to crushing of concrete, thereby 

it’s a ductile failure and gives clear warning before failure. Most of the practical sections are under-reinforced sections 

Thereby the stress in steel reaches the design strength 0.87fy, however, the strain in concrete, €c remain less than ultimate strain 

in concrete €cu = 0.0035. The value of the lever arm = (d-0.42Xu). 

An under-reinforced section is designed using: 

Mu = 0.87* fy * Ast * (d-0.42Xu)       ------------ (1)       

8.3Over-Reinforced Section: 

 A section is said to be over reinforced when the steel in the section is more than that required for a balanced section. It 

is seen that the strain in concrete will reach the ultimate value €cu = 0.0035 prior to the strain in steel reaches. 

€sy1= [
𝑓𝑦+0.002

1.15 𝐸𝑠
]            // strain in steel // 

Crushing failure of over-reinforced initiates in the concrete. It causes a sudden/brittle failure without any prior warning. 

As per Is-456:- 

Designing of an over-reinforced section should be completely eliminated. For the calculation of moment of resistance use: 

Mu = 0.36* fck * b* Xu* (d-0.42Xu)      // Moment of resistance// 

 

8.4Designing Of Beams:- 

Beams are classified into 2 kinds:- 

3) Singly reinforced Beams 

4) Doubly reinforced Beams. 

8.5Singly Reinforced Beams: 

When the steel reinforcement is provided in the tension zone only, such beams are called singly reinforced beams. 

Practically, the beams are designed as under-reinforced sections. The neutral axis of the section is called critical neutral axis and 

that of the under-reinforced section is called actual/existing neutral axis. 

 

 

The critical /limiting neutral axis is given by: 
𝑿𝒖 𝒎𝒂𝒙

𝟎.𝟎𝟎𝟑𝟓
  =  

𝒅−𝑿𝒖𝒎𝒂𝒙
𝒇𝒚

𝟏.𝟏𝟓
∗𝑬𝒔+𝟎.𝟎𝟎𝟐

                       // Depth of critical neutral axis// 

 

The actual neutral axis can be determined by equating tensile and compressive forces- 

(0.36*fck)* (b*Xu) = (0.87*fy* Ast)    //Depth of actual neutral axis// 

 

The moment of resistance can be determined based on the type of the section using: 

Mu = 0.36* fck * b* Xu * (d-0.42Xu)   ---------- (1) 

Mu = 0.87 * fy * Ast * (d-0.42 Xu)                ---------- (2) 
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8.6Doubly Reinforced Section:- 

Beams may be singly or doubly reinforced. In case of singly reinforced beam, the main reinforcement is provided near the face 

of the beam subjected to tension while in case of a doubly reinforced beam, main reinforcement is provided near the faces of the 

beam subjected to tension and compression. A doubly reinforced section is generally provided under the following conditions: 

2) When the depth and breadth of the beam are restricted and it has to resist greater bending moment than a singly 

reinforced beam of that section would do. 

3) When the beam is continuous over several supports, the section of the beam at the support is usually designed as a 

doubly reinforced section. 

4) When the member is subjected to eccentric loading. 

5) When the bending moment in the member reverses according to the loading conditions e.g.: the wall of an underground 

RCC storage reservoir, brackets, etc. 

6) When the member is subjected to shocks, impact or accidental lateral thrust. 

8.7Distribution Of Slab Load On Beams: 

The load of slab is dispersed onto the supporting beams in accordance to clause 23.5 of IS 456-2000, which states that load on 

beams supporting solid slabs in two directions at right angles and supporting uniformly distributed loads, may be in accordance 

with the figure.                                                                                                 
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Load carried by the beam ‘A’ (shorter span) is given by: 

   Equivalent load = 
𝑾𝒍𝒙

𝟑
  

Load carried by beam ‘B’ (longer span) is given by: 

Equivalent load   = 
𝑾𝒍𝒙

𝟔
 *[3-(

𝒍𝒙

𝒍𝒚
) ²] 

In case of one way slabs, 

Load carried by beams along longer span is given by 

   Equivalent load = 
𝑾𝒍𝒙

𝟐
. 

 

 

8.8Design Of Beam 

TYPICAL FLOOR (B7) 

Effective length of beam          = 3.83 m 

Moment @ left span section     = 13.369 KNm 

Moment @ mid span section    = 1.672   KNm 

Moment @ right span section   = 10.025 KNm 

Assume beam dimensions     b = 230 mm 

         D = 375 mm 

Effective depth                       d = 345 mm 

For Fe500 xumax/d = 0.460 

fsc = 0.8*fy N/mm² 

Mu limit = 0.134*fck*b*d² 

 = 84.38KNm 

Design of Beam @ left span section: 

Moment @ left span section = 13.369 KNm 

Mu < Mulimit 

Thus, design as singly reinforced beam 

Reinforcement: 

Mu= 0.87*fy*Ast1*d[1-{(Ast1*fy)/(b*d*fck)}]  

5) Ast1 =102.95 mm² 

. Minimum Ast = 0.85*b*d/fy = 144.67 mm² 

Hence required Ast=144.67 mm² 

Hence provide 2 # 12 mm Ø bars @ the bottom 
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Design of Beam @ mid span section: 

Moment @ mid span section = 1.67 KNm 

Mu < Mulimit 

Thus, design as singly reinforced beam 

Reinforcement: 

Mu= 0.87*fy*Ast*d[1-{(Ast*fy)/(b*d*fck)}]  

5) Ast =12.86 mm² 

Minimum Ast = 0.85*b*d/fy = 144.67 mm² 

Hence provide 4 # 12 mm Ø bars @ the bottom. 

Design of Beam @ right span section: 

Moment @ right span section = 10.025 KNm 

Mu < Mulimit 

Thus, design as singly reinforced beam 

Reinforcement: 

Mu= 0.87*fy*Ast*d[1-{(Ast*fy)/(b*d*fck)}]  

6) Ast =77.20 mm² 

Minimum Ast = 0.85*b*d/fy = 144.67 mm² 

Hence provide 4 # 12 mm Ø bars @ the bottom. 

Check for shear: 

Vu =69.03 KN 

τv = 
𝑣𝑢

𝑏∗𝑑
 = 0.81     pt = 100* Ast/b*d = 0.17 

From table 19 of IS 456:2000 

For M20 grade of concrete, 

τc = 0.29 

Since, τv < τc,safe in shear  

 Sv = 0.75*d = 0.75*370 = 277.5 mm 

 

Hence provide 8mm Ø bars 2 legged stirrups @ 250 mm c/c. 

 

Bending Moment 
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CHAPTER-9 

COLUMNS 

‘COLUMN’ is defined as a structural member subjected to compressive forces in the direction parallel to longitudinal axis. As 

per IS456-2000, columns are defined as compressive members with effective length exceeding 3 times the least lateral dimension. 

If effective length doesn’t exceed 3 times the lateral dimension, then it is called PADESTAL. 

In limit state design, a structural member is designed for limit state of collapse and checked for limit state of serviceability. 

9.1Classification Of Columns: 

Slenderness ratio is defined as ratio of unsupported length to least lateral dimension. As per IS-456-2000, unsupported length is 

the clear distance between the floor and the underside of shallower beam framing into the columns in each dimension. 

For non-rectangular, non-circular columns, slenderness ratio is between unsupported lengths to minimum radius of gyration. 

λ =  
𝑳

𝑳.𝑳.𝑫.  
  

9.1.1Based on slenderness ratio: 

4. Short columns :  λ>3,  ≤12 

5. Long columns  :  λ>12 

(In all cases λ ≤ 60) 

9.1.2Shorter columns: 

Short columns are the columns in which the secondary effects of loads are negligible. Short column with axial load fails by 

compression. Short column with axial load & moment fails due to one which dominates. The columns with large eccentricity are 
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subjected to tension over at least a part of the section and if over loaded may fail due to tension yielding of steel on the farthest 

side of the load. 

9.1.3Long columns: 

  In long columns (also called as slender columns), the slenderness effect produces addition bending moments because of 

transverse deformations, the long columns fail by buckling.Short columns are further divided into 3 types: 

iv) Axially loaded column 

v) Axial load + uniaxial moment 

vi) Axial load + biaxial moment.  

 
9.2Axially Loaded Column: 

All compression members are to be designed for a minimum eccentricity of load. In practice, a truly axially loaded column is 

rare. Thus, every column is designed for minimum eccentricity as per clause 22.4 of IS-456 

   emin =  
𝑳

𝟓𝟎𝟎
+

𝑫

𝟑𝟎
 

                            emin = 20 mm 

Where, L = unsupported length of column 

         D = lateral dimension of column 

9.2.1Axial Load And Uniaxial Bending: 

Design charts for combined axial compression and bending are given in the form of Interaction diagram. In these, curves for 

(Pu/fck)*b*d and (Mu/fck)*b*d² are plotted for different values of P/fck where, P is the percentage of reinforcement. A plot of 

column axially loaded against the moment it may carry is called Interactive Diagram. The axial load capacity decreases as moment 

increases. 

9.2.2Axial Load And Biaxial Bending: 

Professor Bresler has derived that the family of interaction curves may also be approximated to expression 

 emin = (Mux / Mux1)^ɑn + (Muy/ Muy1)^ɑn ≤ 1.0 

where, Mux & Muy = moment about X axis and Y axis respectively. 

       Mux1 & Muy1   = Maximum uniaxial moment capacity for an axial load of          

                                     Pu bending about X axis and Y axis respectively. 

ɑn = pu/Puz 

Puz = 0.45*fck*Ac + 0.75*fy*Asc 

For values of Pu/Puz = 0.2 to 0.8, an varies linearly between 1.0 to 2.0 

9.3Codal Requirements Of Longitudinal Reinforcement For Columns: 

i) Minimum percentage of longitudinal reinforcement shouldn’t be lesser than 0.8 % of the gross cross-sectional area of 

the column. 

Minimum percentage of reinforcement is required to resist the bending moment which may not exist in design. It also reduces the 

effect of creek and shrinkage. 

 

ii) Maximum percentage of longitudinal reinforcement shouldn’t be more than 6% of gross cross-sectional area of the 

column. However, considering practical difficulties in placing and compacting of concrete, it is limited to 4%. 
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iii) Minimum number of steel bars for rectangular columns shall be 4. For circular columns, it is 6. 

 

iv) The diameter of steel bars shall not be less than 12 mm. it is based on the requirements of the stiffness. 

 

v) The spacing of the longitudinal steel bars measured along the periphery of the column shall not exceed 300 mm. 

 

9.4Axial Load And Biaxial Bending: 

Professor Bresler has derived that the family of interaction curves may also be approximated to expression 

 emin = (Mux / Mux1)^ɑn + (Muy/ Muy1)^ɑn ≤ 1.0 

Where, Mux & Muy = moment about X axis and Y axis respectively. 

       Mux1 & Muy1   = Maximum uniaxial moment capacity for an axial load of          

                                     Pu bending about X axis and Y axis respectively. 

ɑn = pu/Puz 

Puz = 0.45*fck*Ac + 0.75*fy*Asc 

For values of Pu/Puz = 0.2 to 0.8, an varies linearly between 1.0 to 2.0 

9.4Codal Requirements Of Longitudinal Reinforcement For Columns: 

1) Minimum percentage of longitudinal reinforcement shouldn’t be lesser than 0.8 % of the gross cross-sectional area of 

the column. 

Minimum percentage of reinforcement is required to resist the bending moment which may not exist in design. It also reduces the 

effect of creek and shrinkage. 

 

2) Maximum percentage of longitudinal reinforcement shouldn’t be more than 6% of gross cross-sectional area of the 

column. However, considering practical difficulties in placing and compacting of concrete, it is limited to 4%. 

 

3) Minimum number of steel bars for rectangular columns shall be 4. For circular columns, it is 6. 

 

4) The diameter of steel bars shall not be less than 12 mm. it is based on the requirements of the stiffness. 

 

5) The spacing of the longitudinal steel bars measured along the periphery of the column shall not exceed 300 mm. 

 

9.5Design of Columns 

Column (C7) first floor 

Column Dimensions: 

Height of column = 2.65 m 

Width of column =300.00 mm 

Depth of column = 530.00 mm 

Axial load acting on the column  

 Pu     =4050. 98KN 

 Mux =14.48 KNm 

Muy =28.15KNm 

Eccentricity along X-axis: 

ex = Muy/Pu 

= (28.15*10^6)/4050.98*10^3) 

                     6.94mm 

exmin is least of the following: 

1)  (L/500) + (D/30)  = 2.65*10^3/500) + (530/30)  =22.97mm 

2) 0.05*D  = 0.05*530 = 26.5 mm 

3) 20mm 

Therefore, exmin =20mm 

Eccentricity along y-axis: 

ey  = Mux/Pu 

     = (14.48*10^6)/4050.98*10^3) 

=3.57 mm  

eymin is least of the following: 

1) (L/500) + (D/30)  = (3*10^3/500) + (460/30)  =  24.36mm 

1) 0.05*D  = 0.05*460  = 26.5mm 

2) 20mm 

Therefore,  eymin  = 20mm 

Since, ex > exmin and ey < eymin, design the columns as Uni-axial column. 

Design of Uni-axial column: 
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Pu/ (fck *b*D) =4050.98*10^3/300*530) =25.48 

Mu = MuY =28.15KNM 

Mu/ (fck *b*D²) =28.15*10^6/ (20*300*530²) = 0.016 

& d’/D = 0.07 

From SP-16 Interaction Curves 

P/ fck = 0.08 

 P = 20*0.08= 1.6% 

 As =pbD/100= (1.6/100)300*530 = 2544mm² 

Hence, provide 8 # - 16mm Ø bars. 

Design of Transverse Reinforcement 

Diameter of lateral ties >= 1/4*(dia of largest longitudinal reinforcement) =[16/4=4mm] 

But in no case < 6 mm. 

Thus, Øt = 8 mm 

Pitch of lateral Ties shall not be more than least of the: 

16*(least dia of longitudinal reinforcement)= [16*16=256] 

300 mm 

  Pitch = 300 mm 

Thus, provide 8 mm Ø lateral ties @ 150 mm c/c spacing 

 

Bending Moment 
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CHAPTER-10 

FOOTING 

Footings are structural members used to transfer the loads from columns onto soil over a wider area safely without causing failure. 

Footings are a part of sub-structure, which remains in contact with the soil. 

The purpose of foundation is to effectively support the structure by: 

1) Transmitting the applied load effects to the soil below, without exceeding the ‘Safe Bearing Capacity’ of the soil. 

2) Ensuring that the settlement of the structure is within the tolerable limits, and as nearly uniform as possible. 

Further, the foundation should provide adequate safety against instability due to overturning or sliding. 

Bearing capacity of soil: 

 It is defined as the maximum intensity of load on the ground. It is determined from ultimate bearing capacity of soil. 

Ultimate bearing capacity is the intensity of loading at the base of the footing which will result shear failure of the soil support. 

Safe bearing capacity is the maximum intensity of loading that the soil will carry without any possibility of shear failure 

irrespective of any settlement that may occur. 

10.1CLASSIFICATION OF FOOTINGS: 

1) Shallow footings       (D<B) 

2) Deep footings            (D>B) 

Shallow footings are classified into: 

1) Isolated footings 

2) Combined footings 

3) STRAP FOOTING 

4) RAFT OR MAT FOOTING       

Isolated footings: The independent footings are also known as isolated footings. The isolated footing is defined as the footings 

which support the individual column. Te isolated footings distributes the load over a sufficiently larger area of the soil stratum to 

minimize the bearing pressure. 

Combined footings: In some cases, it may be inconvenient to provide separate isolated footings for columns on account of 

inadequate areas available in plan. This may occur when two columns are located close to each other or are heavily loaded, 

resulting in an overlap of areas if isolated footing is adopted. Combined footings may be rectangular, trapezoidal, strap, wall 

footing. 

Combined footing is adopted in case of: 

1) The projection of the footing of an exterior column is likely to project into other’s property line. 

2) Insufficient bearing capacity of sub-soil requiring large areas. 

3) Sensitivity of the super-structure to differential settlements. 

4) Restrictions in both the directions. 

                                             
  3.    Strap Footing: It is also one of the types of combined footing. It consist of an Isolated footing of two columns connected 

by a beam called strap beam. 

Raft Or Mat Footing: When the column loads are heavy or the safe bearing capacity of soil is very low, the required footing 

area become very large and the footings of adjacent column may overlap. In such case, for all the columns a common footing may 

be provided as shown in fig. a raft or mat footing is a solid reinforced concrete slab covering entire area beneath the structure and 

supporting all the columns. Such foundation due to its own rigidity minimizes differential settlements. 
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10.2PRESSURE DISTRIBUTION BELOW THE FOOTING: 
The contact pressure distribution under a symmetrically loaded footing is not uniform. 

      The pressure intensity depends up on. 

1.  Rigidity of the footing  

   2.  Type of soil and    

   3.  Depth of foundation. 

When a rigid footings rests on loose sandy soil. The pressure intensity is more at the center when compared to the edges and the 

pressure distribution is parabolic. For rigid footings on clayey soils, the pressure intensity is more at the edges compared to the 

center and the pressure distribution is parabolic as shown in fig. for rigid footings, the variations of pressure decreases with 

increase in the depth of foundation. If the footing is flexible, the contact pressure distribution is uniform irrespective of the type 

of soil. 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

10.3GENERAL DESIGN REQUIREMENT FOR FOOTINGS (IS 456-2000)              

 Minimum Thickness at Edges: In reinforced and plain concrete footings, the minimum    thickness at the edges shall be taken 

as given below. 

For footings on soil – 150 mm 

For footings on piles- 300 mm 

Moments and Forces: The bending moment at any section shall be determined by passing through the section vertical plane 

which extends completely across the footing, and computing the moment of the forces acting over the entire area of the footing 

on one side of the said plane. The critical section for determination of bending moment shall be as follows. 

1.)  At the face of the column, pedestal or wall, for footing supporting a Concrete column, pedestal       

2.)   Halfway between the face of the column or pedestal and the edge of the Gusseted base,     for footing under gusseted bases. 

3.)    Halfway between the center-line and edge of the wall, for footing under Masonry walls. 

      Shear: The shear strength of footing is governed by the more severe of the following                       condition 

1. For one way or beam action, the critical section for shear shall be assumed as a vertical section located from the face of 

the column, pedestal or wall at a distance equal to the effective depth for footing on soil and a distance equal to half the effective 

depth in case of footing piles. 

2. For two way action of the footing, the critical section for shear shall be at a distance of d/2 from the periphery of the 

column perpendicular to the plane of the slab where “d” is the effective depth of the section. Bond: The critical section for 

P P

(a) sandy soil (b) claye soil

(c) assumed
uniform footings
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checking the development length in a footing shall be assumed at the same planes as those prescribed for bending moment and 

also for other planes where abrupt changes of section occur. 

 

Tensile Reinforcement: Tension reinforcement should be provided to resist the bending moment obtained in (2) above. The total 

tensile reinforcement shall be distributed across the corresponding resisting section as given below. 

(a) In one way reinforced footing, the reinforcement shall be distributed uniformly across the full width of footing. 

 (b) In a two way reinforced square footing, the reinforcement extending in each direction shall be distributed uniformly across 

the full width of footing. 

(c) In a two way reinforced rectangular footing, the reinforcement in the long direction is placed uniformly across the full width 

of the footing. For reinforcement in the short direction, a central band equal to the width of footing shall be marked along the 

length of the footing and portion of reinforcement determined in accordance with the equation given below shall be uniformly 

distributed across the central band. 

 
𝑟𝑒𝑖𝑛𝑓𝑜𝑟𝑐𝑒𝑚𝑒𝑛𝑡 𝑖𝑛 𝑐𝑒𝑛𝑡𝑟𝑎𝑙 𝑏𝑎𝑛𝑑

𝑡𝑜𝑡𝑎𝑙 𝑟𝑒𝑖𝑛𝑓𝑜𝑟𝑐𝑒𝑚𝑒𝑛𝑡 𝑖𝑛 𝑠ℎ𝑜𝑟𝑡 𝑑𝑖𝑟𝑒𝑐𝑡𝑖𝑜𝑛
=

2

𝛽 + 1
 

Where β = ratio of longer side to the shorter side of the footing 

    Bending moment: 

  The column load coming on the footing is not distributed evenly over the complete foundation. At first, a large part of 

the load comes directly under the column and this produces a small settlement of the footing directly under the column. The 

magnitude of the settlement is less at the edge than at the center. Therefore, the cantilever projections projecting out from the 

column in both the directions and loaded upward by the soil pressure bends as a curve. Due to bending of the cantilever projections, 

bending tensile stresses develop in both these directions at the bottom surface. Therefore, steel bars are provided in tension zone 

in two layers perpendicular to each other and parallel to the edges. 

 
Assuming the bearing pressure of the soil to be uniform at the base of the footing, the bending moment at any section XX1 at a 

distance from free edge shall be determined by passing through the section a vertical plane which extends completely across the 

footing and calculating the moment of forces acting over due to entire area of the footing on one side of the said plane. 

    Mxx   =    
𝒒𝒖∗𝒙²

𝟐
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10.4Depth of foundation: 

 The depth of foundation is decided keeping the following factors into consideration: 

1) The safe bearing capacity of the soil is secured. 

2) In case of clay, the foundation is to be penetrated below the zone where shrinkage and swelling of soils due to seasonal 

weather changes are likely to cause significant movement. 

IS: 1080-1962 recommends that the minimum depth of the foundation of at least 500mm below the ground level, should be 

provided in all types of soils. In case of rock or such other weather resisting natural ground, the top soil may be removed. The 

depth of the foundation is determined by Rankine’s formula. 

   Dmin = 
𝐏

𝜸
 * [

𝟏 − 𝐬𝐢𝐧Ø

𝟏 + 𝐬𝐢𝐧Ø
]² 

Where  Dmin         = minimum depth of foundation 

      P    =   gross bearing capacity of the soil 

      𝛄        =   density of soil                                 

10.5Critical Sections:- 

1) B.M. is Zero at the ends and maximum at the face of column. 

2) It is subjected to 2 types of shear: 

     One-Way shear is critical at a distance‘d’ from face of column 

    Two-Way shear is critical at a distance‘d/2’ from face of column. 

    Among them Two-Way shear is more critical. 

3) For a brick/masonry wall (flexible) critical sections is at ‘b/4’ from center line of footing. 

4) In case of circular column, inscribe a square such that diagonal of Square is equal to diameter of circle. 
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10.6Design of Footing 

  
 

 

   

 

 

CHAPTER-11 

STAIRCASE 

A stair is a series of steps arrange in such a manner as to connect different floors of a building. Stairs are designed to provide an 

easy and quick access to the different floors. 

Stairs are provided in a building to afford a means of communication between various floors. They are called staircase. Since they 

have to perform the very important function, the slab over which the steps rests should be design properly to provide maximum 

comfort, easy and safety. The most important aspect in providing staircase is it location. The location of staircase should be such 

as to provide as easy to that in case of any casualty, e g, and fire break earth quakes flooding etc. Occupants should be placed in 

the center or to the side of a building. The location depends up on the position of the room and the type of approach needed. In 

commercial buildings, it should be placed centrally so as to: 

1. Provide easy access to all shops/offices 

2. Maintain privacy. 

The inclined slab of a stair is known as height of stair while the straight portion other than the floor level is known as landing. 

While song on flight, one travels vertically, the landing is provided midway both to turn the position and lower to relax while 

going up. 

The vertical height of a stair is known as RISE and the available horizontal distance on a stair is known as TREAD. 

• Rise of step   - 150 to 300 mm. 

• Tread of step   -200 to 300mm. 

• Width of staircase   -   1m in residential building to 2m or public building. 

 

11.1 Classification Of Stairs: 

According to structural aspect 

1. Straight stairs 

2. Quarter landing stairs 

3. Dog legged stair4.Open well stairs 

 

 

11.2Guidelines for Fixing the Dimensions of the Component Parts of Stairs: 

• The raiser should be between 150 mm to 180 mm and tread between 220 mm to 250 mm for residential buildings. The 

raiser should be between 120 mm to 150 mm and tread between 250 mm to 300 mm for public buildings. 
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• The sum of the tread and twice the rise (T +2R) should be between 500 mm to 650 mm. 

 

• The width of the stairs should be between 0.8 to 1m for residential buildings. The width of the stairs should be between 

1.8 to 2 m for public buildings. 

 

• The width of the landing should not be less than width of stairs. 

 

• The number of steps in each flight should not be greater than 12. 

 

• The pitch of the stairway should not be greater than 38 ͦ . 

 

• The head measured vertically above any step or below mid landing shall not be less than 2.1 m. 

 

• Avoid winders as far as possible. 

 

11.3 LAYOUT OF STAIRS 

The size of staircase room and the proportion of the beams and columns along the boundary govern the type and layout of staircase. 

• Longer span for flight are to be avoided, as the staircase slabs are heavier then the roof slabs because  

• Heavier dead load due to inclined length of slab and due to the additional weight of steps. 

 

• Stair flights are supported on beams or walls. 

 

• Landing beams are provided if the span of the stairs flight exceeds 4.5 m. 

 

• Skew supports are avoided as for as they induce torsion in the flight 

 

CHAPTER-12 

CONCLUSION: 

 

1. Analysis and Designing using Software like ETABS. Safe lot of time in design work compare to manual design work. 

2. Details of each and every member can be obtained using ETABS. 

3. In this report a design of Multi storeyed Building for residential purpose is presented. 

4. We have successfully completed the planning and designing Of a Multi Storeyed (G+5) Structure 

5. Durability of building mainly depends on proper construction process, designing and proper use ofmaterials6.As per our 

Supervision we have concluded that during our training we were familiar with the designing and analysis of a residential building 

and it’s detailing. 
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